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by Roland

USB MIDI INTERFACE

- UM-2Ex

Owner’s Manual

Thank you, and congratulations on your chdice of the UM-2EX USB MIDI Interface.

Before using this unit, carefully read the sectlons entitled: “USING THE UNIT
SAFELY” and “IMPORTANT NOTES” (p. 2; p. 4). These sectlons provide K
Important Informatlon concerning the proper operation of the unit. Additionally,
In order to feel assured that you have galned a good grasp of every feature
provided by your new unit, Owner's manual should be read In Its entirety. The
manual should be saved and kept on hand as a convenlent reference.
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USING THE U SAFEL

| INSTRUCTIONS FOR THE PREVENTION OF FIRE, ELECTRIC SHOCK, OR INJURY TO PERSONS

About AWARNING and A\ CAUTION Nofices

About

the Symbols

/AWARNING
improperly.

Used for instructions intended to alert
the user to the risk of death or severe
injury should the unit be used

A

The A symbol alerts the user to important instructions
or wammss.’l'he specific meaning of the symbol is
determined by the design contained within the
triangle. In the case of the symbol at left, it is used for
general cautions, wamings, or alerts to danger.

Used for instructions i

improperly.

A\ €AUTION

animals or pets.

ded to alert
the user to the risk of injury or material
damage should the unit be used

* Material damage refers to damage or
other adverse effects caused with
respect to the home and all its
furnishings, as well to domestic

€

The © symbol alerts the user to items that must never
be carried ouf (are forbidden). The specific thing that
must not be done is indicated by the design contained
within the circle. In the case of the symbol at left, it
means that the unit must never be disassembled.

The @ symbol alerts the user to things that must be
carried out. The specific thing that must be done is
indicated by the design contained within the circle. In
the case of the symbol at left, it means that the power-
cord plug must be unplugged from the outlet.

ALWAYS OBSERVE THE FOLLOW:NG

| /\WARNING

/A WARNING

¢ Before using this unit, make sure to read
the instructions below, and the Owner’s
Manual.

A

¢ Do not open (or modify in any way) the
unit,

®

* Do notattempt to repair the unit, or replace
parts within it (except when this manuat
provides specific instructions directing you
to do s0). Refer all servicing to your
retailer, the nearest Roland Service Center,
or an authorized Roland distributor, as
listed on the “Information” page.

* Never use or store the unit in places that
are:

Subject to temperature extremes (e.g.,
direct sunlight in an enclosed vehicle,
near a heating duct, on top of heat-
generating equipment); or are

Damp (e.g., baths, washrooms, on wet
floors); or are

Humid; or are

Exposed to rain; or are

Dusty; or are

Subject to high levels of vibration.

®
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| /\WARNING

/A WARNING

* Make sure you always have the unit placed
so it is level and sure to remain stable.
Never place it on stands that could wobble,
or on inclined surfaces.

¢ Do notallow any objects (e.g., flammable
material, coins, pins); or liquids of any kind
(water, soft drinks, etc.) to penetrate the
unit.

Q
®

» Immediately disconnect the USB cable, and
request servicing by your retailer, the
nearest Roland Service Center, or an autho-
rized Roland distributor, as listed on the
“Information” page when:

* If smoke or unusual odor occurs

¢ Objects have fallen into, or liquid has
been spilled onto the unit; or

¢ The unit has been exposed to rain (or
otherwise has become wet); or

¢ The unit does not appear to operate
normally or exhibits a marked changein
performance.

e Inhouseholds with small children, an adult
should provide supervision until the child
is capable of following all the rules
essential for the safe operation of the unit.

A

® Protect the unit from strong impact.
(Do not drop itf)

O

DONOT play a CD-ROM disc on a conven-
tional audio CD player. The resulting
sound may be of a level that could cause
permanent hearing loss. Damage to
speakers or other system components may
result.

/A\ CAUTION

Try to prevent cords and cables from
becoming entangled. Also, all cords and
cables should be placed so they are out of
the reach of children.

A

Never climb on top of, nor place heavy
objects on the unit.

O

Disconnect all cords coming from external
devices before moving the unit.
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l IMPORTANT NOTES

In addition to the items listed under “USING THE UNIT SAFELY” on pages 2 and 3, please read and
observe the following:

Placement

This device may interfere with radio and
television reception. Do not use this device in the
vicinity of such receivers.

Noise may be produced if wireless communica-
tions devices, such as cell phones, are operated in
the vicinity of this unit. Such noise could occur
when receiving or initiating a call, or while
conversing. Should you experience such
problems, you should relocate such wireless
devices so they are at a greater distance from this
unit, or switch them off.

Do not expose the unit to direct sunlight, place it
near devices that radiate heat, leave it inside an
enclosed vehicle, or otherwise subject it to
temperature extremes. Excessive heat can deform
or discolor the unit.

When moved from one location to another where
the temperature and/or humidity is very
different, water droplets (condensation) may
form inside the unit. Damage or malfunction may
result if you attempt to use the unit in this
condition. Therefore, before using the unit, you
must allow it to stand for several hours, until the
condensation has completely evaporated.

Maintenance

For everyday cleaning wipe the unit with a soft,
dry cloth or one that has been slightly dampened
with water. To remove stubborn dirt, use a cloth
impregnated with a mild, non-abrasive
detergent. Afterwards, be sure to wipe the unit
thoroughly with a soft, dry cloth,

Never use benzine, thinners, alcohol or solvents
of any kind, to avoid the possibility of discolor-
ation and/or deformation.

Additional Precautions

Use a reasonable amount of care when using the
unit’s buttons, sliders, or other controls; and
when using its jacks and connectors. Rough
handling can lead to malfunctions.

When connecting / disconnecting all cables,
grasp the connector itself—never pull on the
cable. This way you will avoid causing shorts, or
damage to the cable’s internal elements.

To avoid disturbing your neighbors, try to keep
the unit’s volume at reasonable levels (especially
when it is late at night).

‘When you need to transport the unit, pack it in
shock-absorbent material. Transporting the unit
without doing so can cause it to become
scratched or damaged, and could lead to
malfunction.



Handling CD-ROMs

*  Avoid touching or scratching the shiny underside
(encoded surface) of the disc. Damaged or dirty
CD-ROM discs may not be read properly. Keep
your discs clean using a commercially available
CD cleaner.

* Microsoft and Windows are registered trademarks of Microsoft Corporation.

* The screen shots in this document are used in compliance with the guidelines of the Microsoft Corporation.
*  Windows® is known officially as: “Microsoft® Windows® operating system.”

* Apple and Macintosh are registered trademarks of Apple Computer, Inc.

* Mac OS is a trademark of Apple Computer, Inc.

* All product names mentioned in this document are trademarks or registered trademarks of their respective
owners.

* OMS s a registered trademark of Opcode Systems, Inc.
* FreeMIDI is a trademark of Mark of the Unicorn, Inc.



Contents of the Package

The UM-2EX includes the following items. When you open the package, first make sure that
all items are included. If any are missing, contact the dealer where you purchased the UM-
2EX.

USB MIDI Interface UM-2EX

H o

CD-ROM
This contains drivers for use with the UM-2EX.

Owner’s Manval
This is the manual you are reading. Please keep it on hand for reference.
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Names of Things and What They Do

@ UsB Cable
Use this when connecting the UM-2EX to your computer.
© USB Indicator

This will light when you've connected the UM-2EX to your computer and your computer has
detected the UM-2EX.

In order for your computer to detect the UM-2EX, you must install the driver and make settings.
(—"“Gettlng Connected and Installing Drivers” Windows (p. 10) / Macintosh (p. 20))

€© ADVANCED (mode select) Switch

This switches the operating mode.
* Standard driver mode supports only Windows XP SP2 or later, and Mac OS X.
ou a| Windo e /2 P or XP SP1, o ou are us| ac 0S 9, you
ust tu DV, ED (mod ct) Switc| before you connec M-2EX to your
computer,

This mode utilizes the UM-2EX’s special, advanced MIDI driver.

ON This advanced driver uses *FPT technology for rapid, high-performance
{Advanced mode) MIDI transmissions.

We recommend use of this mode.

QOFF This mode uses the standard MIDI driver included with the OS.
(Standard driver Use this if you do not have the special driver installed.
mode)

*FPT=Fast Processing Technology of MIDI Transmission



O MIDI N Indicator
This lights when MIDI messages are received from the device connected to MIDI IN.
@ MID! IN Connector

Connect this to the MIDI OUT connector of the device (such as a MIDI keyboard) that will be
transmitting MIDI messages to your computer.

O MIDI OUT 1 Indicator
This lights when MIDI messages from the computer are transmitted.
@ MIDI OUT 1 Connector

Connect this to the MIDI IN connector of the device (such as a sound module) that is to be
employed by your computer for playing music.

© MIDI OUT 2 Indicator
This lights when MIDI messages from the computer are transmitted.
© MIDI OUT 2 Connector

Connect this to the MIDLIN connector of the device (such as a sound module) that is to be
employed by your computer for playing music.



I Getting Connected and Installing Drivers (Windows)

About the Driver Modes

What is a driver?

A “driver” is software that transfers data between the UM-2EX and application software running
on your computer, when your computer and the UM-2EX are connected. The driver sends data
from your application to the UM-2EX, and from the UM-2EX to your application.

About the driver modes

The UM-2EX has two operating modes, Advanced mode and Standard driver mode, and a
different driver is used by each mode.

* Standard driver mode supports only Windows XP SP2 or later.

dow: e /2 st tu e ADV. D
ch ON before yo B compute
This mode utilizes the UM-2EX’s special, advanced MIDI driver.
ON ‘This advanced driver uses *FPT technology for rapid, high-performance
(Advanced made) || MIDI transmissians.

We recommend use of this mode.
(= “Installing the Driver” (p. 11))

OFF This mode uses the standard MIDI driver included with the OS.
(Standard drlver || Use this if you do not have the special driver installed.
mode) (- “Instaliation of the standard driver” (p. 34))

*FPT = Fast Processing Technology for MIDI Transmission
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Installing the Driver

The installation procedure will differ depending on your system.
Please proceed to one of the following sections, depending on the system you use.

* Windows XP/2000 users p-11
¢ Windows Me/98 users p-16

Steps to be performed on the UM-2EX itself are marked by a symbol.

Windows XP/2000 users

1. With the UM-2EX left unconnected, start up Windows.
Do not connect the UM-2EX to the computer until you reach Step 13 (p. 13).
* Disconnect all USB cables except for a USB keyboard and USB mouse (if used).
* Log onto Windows using a user name that has administrative privileges (such as Administrator).
2. Open the System Properties dialog box.
Windows XP:
1. Click the Windows start menu, and from the menu, select Control Panel.
2. In “Plck a category,” click “Performance and Malntenance.”
3. In “or plck a Contro! Panel icon,” click the System icon.
Depending on your setup, the System icon may appear directly in the Control Panel (Classic
view). If so, double-click the System icon.
Windows 2000:
1. Click the Windows Start menu, and from the menu that appears, select Settings | Control
Panel.
2. In Contro! Panel, double-click the System icon.
3. Click the Hardware tab, then click [Driver Signing].
The Driver Slaning Options dialog box will open.
4, In the Driver Signing Options dialog box, select “Ignore,” then click [OK].
If the current setting is “Warn” or “Block,” change this to “Ignore.” Then, when you've finished
installing the driver, change it back to the original setting.

11



5. Click [OK] to close the System Properties dialog box.
6. Exit all currently running software (applications).
Also close any currently open windows. If you are using virus checking or similar software, you
must exit all of these programs as well.
7. Prepare the CD-ROM.
Insert the CD-ROM into your computer’'s CD-ROM drive.
* If the message “Windows can perform the same action each time you insert a disk or
connect a device with this kind of file” appears, [Cancel].
8. From the Windows start menu, choose Run...
9. In the Open field of the “Run...” dialog box, type the following and click [OK].
D: \Driver\XP2k\setup.exe
* The drive name is “D:" in the example shown here, but may be different on your system, Use the drive
name for your CD-ROM drive.
10. The Driver Setup dialog box will appears.
Click [Next].
11. To begin the installation, click [Next] once again. Installation will begin.
Windows XP:
If “Driver Signing Options” in step 4 is set to anything other than “Ignore,” a dialog box with
an “” or “x” symbol will appear. If a [Continue Anyway] button is displayed, click
[Continue Anyway] to proceed with the installation. If you are unable to continue, click [OK]
and repeat the driver installation from step 1.

Windows 2000:
If “Driver Slgning Optlons” in step 4 is set to anything other than “Ignore,” a dialog box
indicating “Dlgital Signature Not Found” will appear. If a [Yes] button is displayed, click
[Yes] to proceed with the installation. If you are unable to continue, click [OK] and repeat the
driver installation from step 1.

The “Setup Is now ready to Install the drivers” dialog box will appear.
Now you are ready to install the driver.

12, Set the UM-2EX’s ADVANCED (mode select) Switch to ON.
* The driver cannot be installed by means of the following procedure if the switch is set to OFF.

I you are usl dows Me /21 P o] S| DV, ED
od ect) Switc efore you connect the UM-2EX to your computer.
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13. Connect the UM-2EX to your computer.
A message of “Found New Hardware” will appear. Please wait.

* This unit is equipped with a protection circuit, A brief interval (a few seconds) after connecting the UM-
2EX is required before the unit will operate normally.

Windows XP:

1. The Found New Hardware Wizard dialog box will appear.
If the message “Connect to Windows Update to search for software?” appears, choose “No”
and then click [Next].

2. Make sure that “EDIROL UM-2" is indicated. Then, choose “Install the software
automatically (Recommended)” and click [Next].
* If “Driver Signing Optlons” in step 4 is set to anything other than “Ignore,” a dialog box with an
“I" symbol will appear. Click [Continue Anyway] to proceed with the installation.

Windows 2000:
If “Driver Signing Options” in step 4 is set to anything other than “Ignore,” a dialog box
indicating “Digital Signature Not Found” will appear. Click [Yes] to proceed with the
installation.
14, The Completing the Found New Hardware Wizard dialog box will appear.
Click [Finish].
15.In the Driver Setup dialog bo, click [Close].
This completes driver installation.

If the Change System Settings dialog box appears, click [Yes]. Windows will restart
automatically.

* Ifyou changed the “Driver Signing Options” setting (step 4 on p. 11), restore the original seitings
after Windows has restarted.

Next, in order to ensure that MIDI processing occurs smoothly, you need to make settings so that
Background Services is given priority.
(= “Giving priority to Background Services” (p. 14))
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M Giving priority to Background Services
To ensure that MIDI data is handled smoothly, proceed as follows to make this setting.

Windows XP:
1. Open the System Properties dialog box.
1. From the Windows start menu, choose Control Panel.
2. In “Pick a category,” click “Performance and Malntenance.”

3. In “or Pick a Control Panel icon,” click the System icon.
Depending on your setup, the System icon may appear directly in the Control Panel (Classic
view). If so, double-click the System jcon.

2. Click the Advanced tab,

3. In the right side of the Performance area, click [Settings].
The Performance Options dialog box will open.

4. Click the Advanced tab.
5. In the Processor scheduling area, choose

“Background services,” and click [OK].I
Frecesser heddng
By defauk, th shace of
processor tims o run your programs,
Adjust for best performanse=t”
2
Metoory usaoe
By defauk, th share of
memory £  your programs.
Adjust for best performance oft
©Programs O5ystemcache
Vbud memery
FRwera RAM,
Total paging fiko stza For ol drivest %610
!
6. In the System Propertles dialog box, click [OK], =]

The System Properties dialog box will close.
Next, you'll make the driver settings, (-» “Setting the Driver” (p. 17))



Windows 2000:
1. Click the Windows Start button, and from the menu that appears, select Settings | Control
Panel.

2, In Control Panel, double-click the System icon.
3. Click the Advanced tab.

4, At the right of the Performance field, click [Performance Options].
The Performance Options dialog box will appear.

5. In the Application response field, choose
“Background services” and click [OK].

6. Click [OK] to close the System Properties dialog box.
The System Properties dialog box will close.

Next, you'll make the driver settings. (= “Setting the Driver” (p. 17))
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Windows Me/98 users

T. With the UM-2EX left unconnected, start up Windows.
Do not connect the UM-2EX to the computer until you reach Step 9.

2. Exit all currently running software.
Also close any open windows. If you are using virus checking or similar software, be sure to exit it
as well.

3. Prepare the CD-ROM.
Insert the CD-ROM into the CD-ROM drive of your computer.

4. Click the Windows Start menu. From the menu that appears, select Run....
The “Run...” dialog box will appear.

5. In the dialog box that appears, input the following into the “Open” field, and click [OK].
D: \Driver\Me98\Setup.exe

* The drive name is “D:" in the example shown here, but may be different on your system., Use the drive
name for your CD-ROM drive.

6. The Driver Setup dialog box will appears. Click [Next].

7. To begin the installation, click [Next] once again. Installation will begin.
The “Setup Is now ready to install the drivers” dialog box will appear.
Now you are ready to install the driver.

8. Set the UM-2EX’s ADVANCED (mode select) Switch to the ON position.

* The driver cannot be installed by means of the following procedure if the switch is set to OFF.,

e usin s e /2 or XP SP1, you must turn the ADV, ED
e UM-2EX to vour co

9. Connect the UM-2EX to your computer.

A message of “Found New Hardware” will appear. Please wait.

* This unit is equipped with a protection circuit. A brief interval (a few seconds) after connecting the UM-
2EX is required before the unit will operate normally.

10. In the Driver Setup dialog box, click [Close].
Next, you'll make the driver settings. (> “Setting the Driver” (p. 17))
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Setting the Driver

The following describes the settings needed to use the UM-2EX with Media Player or other

sequencer software using Windows standard device settings.
If you are using sequencer software that does not utilize Windows standard device settings, make

the device settings within the sequencer software.

Windows XP users

1. Open the Sounds and Audio Devices Properties dialog box.
1. From the Windows start menu, choose Control Panel.

2. In “Plck a category,” click Sound, Speech, and Audio Devices.

3. In “or Pick a Control Panel icon,” click the Sounds and Audlo Devices icon.
Depending on your setup, the Sounds and Audlo Devices icon may appear directly in the
Contro! Pane! (Classic view). If so, double-click the Sounds and Audlo Devices icon.

2. Click the Audio tab.

3. For MIDI music playback, click the ¥ located at the right
of [Defauit device], and select the MIDI device from the
list that appears.

Selecting “EDIROL UM-2 MIDI 1” enables sounds to be
played from the sound module connected to the UM-
2EX’s MIDI OUT 1 connector with Media Player or other
sequencer software utilizing Windows standard device
settings.

4, Close the Sounds and Audlo Devices Properties dialog
box.
Click [OK] to complete the settings.

Seunds and Audle Devices Dispiies

{ Veime } Sonds ] Auxdo t Vocs § Huden

ttve ery defmit devces

Saundplvback
@ Defok devce:
[seTizvan H
Sondiscadg
/g Defimd devce:
fsemzven Wi
3
MDA g plback
QG Defakdoven:
== (1 EDWO Unk-2 MDY o

e I
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| W'ndows 2000/Me users

1. Open the Sounds and Multimedia Properties dxalog box.

1. Click the Windows start button, and from the menu that appears, select Settings ! Control

Panel.

2. In Control Panel, double-click the Sounds and Multimedia icon.
If Sounds and Multimedia icon is not displayed, click “Show all control panel options” in

the frame at the left.
2. Click the Audio tab.

3. Click ¥ in the MIDI Muslc Playback [Preferred device]
menu and select the MIDI device from the list that
appears.

Selecting “EDIROL UM-2 MIDI 1” enables sounds to be
played from the sound module connected to the UM-
2EX’s MIDI OUT 1 connector with Media Player or other
sequencer software utilizing Windows standard device
settings.

4. Close the Sounds and Multimedia Properties dialog box.
Click [OK] to complete the settings.
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Windows 98 users

1. Open the Multimedia Properties dialog box.

1. Click the Windows Start menu, and from the menu that appears, select Settings | Control

Panel.

2. In Control Panel, double-click the MultimedIa icon.
2, Click the MIDI tab.

3. Select [Single instrument), and select the MIDI device
from the list that appears.
If you want to use Media Player to play a sound module
connected to the UM-2EX’s MIDI OUT 1 connector, select
“EDIROL UM-2 MID1 1.”

4, Close the Multimedia Properties dialog box.
Click [OK] to complete the settings.

; : [ ——
e E
1 EDIROL UN-2 MiDI 2
Foland KPU-4T1
[WavsTable Synthetia P
W b

G Cumons configuaton
| o— ]|
T A fowlnanmert, |
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I Getting Connected and Installing Drivers (Macintosh)

About the Driver Modes

What is a driver?
A “driver” is software that transfers data between the UM-2EX and application software running
on your computer, when your computer and the UM-2EX are connected. The driver sends data
from your application to the UM-2EX, and from the UM-2EX to your application.

About the driver modes
The UM-2EX has two operating modes, Advanced mode and Standard driver mode, and a
different driver is used by each mode.
* Standard driver mode supports only Mac OS X,

ou’re using OS ou must turn the ADVANCED (mode select) Switch ON before you
connect the UM-2EX to your Magintosh.

This mode utilizes the UM-2EX's special, advanced MIDI driver.

oN This advanced driver uses *FPT technology for rapid, hlgh -performance
MIDI transmissions.

(Advanced mode) We recommend use of this mode.

(- “Driver Installation and Settings” (p. 20))

OFF This mode uses the standard MIDI driver included with the OS.
(Standard driver || Use this if you do not have the special driver installed.
mode) (—“Installation of the standard driver” (p. 34))

*FPT = Fast Processing Technology for MIDI Transmission

Driver Installation and Settings

The installation procedure will differ depending on your system.
Please proceed to one of the following sections, dependmg on the system you use.
© Mac OS X users. (p.21)

* Mac O S9 users (p-25)

Steps to be performed on the UM-2EX itself are marked by a symbol.
20



’ Mc;c (0} X>users

H Installing the driver

* Ifthe “Authenticate" dialog box appears during the i
* What you actually see on your Macintosh screen may be different, dep
environment and the operating systent you're using.
1. With the UM-2EX left unconnected, start up Macintosh,
* Disconnect all USB cables other than those for your keyboard and mouse, and restart your Macintosh.

Hation, input the p d and click “OK.”
ding on your computing

2. Exit all currently running software (applications).

3. Prepare the CD-ROM.
Insert the CD-ROM into the CD-ROM drive of your Macintosh.
4, In the Driver (Mac OS X) folder of the CD-ROM, double-click UM2USBDriver.pkg.
A message such as “This Installer package needs to0...” may appear.
Click “Contlnue.”
5. The display will indicate “Welcome to the EDIROL UM-2Driver Installer.” Click [Continue].

6. The display will indicate “Select a Destination.”
Click the drive in which the operating system is installed to select it, and then click [Continue].

* Select your startup disk as the drive.

7. The display will indicate “Easy Install.”
Click [Install] or [Upgrade].

8. The display will indicate “Installing this software requires you to restart your computer when
the installation Is done.”
Click [Continue Installation].

9. The display will indicate “The software was successfully Installed.”
Click [Restart] to restart your Macintosh.
This completes installation of the UM-2 driver.
Next, make MID] device settings. (—*“Setting the driver” (p. 22))
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Setting the driver
The following describes the settings enabling use of the UM-2EX with sequencer software using
Macintosh standard device settings.
1 you are using sequencer software that does not utilize Macintosh standard device settings, make
the device settings within the sequencer software.
* What you actuall,

I

see on your Macintosh screen may be different, dep
t and the operating system you're using.

1. Set the UM-2EX’s ADVANCED (mode select) Switch to the ON position.

2, Connect the UM-2EX to your Macintosh.
* Connect the cable to the USB connector of the Macintosh itself, not to the USB connector of the keyboard.

* This unit is equipped with a protection circuit. A brief interval (a few seconds) after connecting the UM-
2EX is required before the unit will operate normally.

3. Open the Applications folder of your Macintosh hard disk. In the Utilitles folder, double-click
Audlo MIDI Setup to open the Audio MID] Setup dialog box.

fe@e

1g on your computing

- Audio MiD! Setitp
{ Audio Devices { MiDi Devices Y1 4 Click MIDI Davices

Yero2™] 6 Click Add Device | X

KpanMiDl  TestSetup
4, Click the MIDI Devices tab.

7 Click Show Info
5, Confirm that UM-2 appears in the Audlo MIDI Setup dialog box.
* If UM-2 does not appear or if it is grayed out, it means that the UM-2EX is not being recognized properly.
Click Rescan MIDI, Also try disconnecting and reconnecting the UM-2EX,

* Previous settings from installation of a different version of the driver may still remain. If this is the case,
click on the grayed UM-2 or EDIROL UM-2 to select it, then click Remove Selected Device to delete
the settings.

6. Click Add Device twice.
Two new external device will appear.




7. Set the Device Name.
1. With the new external device selected, click Show Info.
2, Enter the name in the Device Name field.

By UM-2 WO T Froperiies
Device Hame. {UN-2 D11 ] Oevice Hame [UM-2 it 2 }
Manufacturer = Sanufacturer
= L |

@ Uove information (%) [l More Wnformavion (%]

G (o) Ty (i)

8. Connect the ¥ and A symbols (which signify the outputs and inputs) of the UM-2 icon to those of
the new external device icon by using the mouse to drag between them.

606 Audio MIDI Setup
- { Audio Devices | MIDi Devices }—— - = ———~ - -

View Kor Size Configuration AddDeviee o= <o Resan MOl TestSetup

g Use the mouse to
drag a connection

_ Umezmioil @ UM-2 MiDi2 (D

9. If running Mac OS X v10.2 or earlier:
Close the Audio MIDI Setup dialog box. The settings are completed.
If running Mac OS X v10.3 or [ater:
Confirm that MID is being transmitted and received correctly. Perform Steps 10-13 (p. 24).



10. Click Test Setup. 8086 Audia MIDI Setup
The shape of the mouse pro— T - —
cursor changes JJ. —g— = X

11. Click the area shown in e bt s

the illustration. If the
corresponding MIDI
OUT indicator of the
UM-2EX blinks, the
settings have been made
correctly.

12. Click Test Setup and
complete the
confirmation.

13. Close the Audlo MIDI Setup dialog box.

When using the UM-2EX with your sequencer software

Before using the UM-2EX with your sequencer software, please note the following points.

» Connect the UM-2EX to your Macintosh before you start up your sequencer software,

¢ Do not disconnect the UM-2EX from your Macintosh while your sequencer software is running.
Quit your sequencer software before you disconnect the UM-2EX from your Macintosh.

¢ The UM-2EX will not operate in the Mac OS X Classic environment. Use the UM-2EX when
the Classic environment is not running.
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Mac 05 9 users

N Installing the UM-2 driver
Use either OMS or FreeMIDI as the MIDI driver,

The included UM-2 drlver is an add-on module for using the UM-2EX with OMS or FreeMIDI.
OMS can be found in the OMS 2.3.8 E folder within the OMS (Mac OS 9) folder of the CD-ROM.
If you would like to know more about OMS, refer to OMS_2.3_Mac.pdf which can be found in the
same folder.

* Either OMS or FreeMIDI must be installed in your Macintosh, as appropriate for the sequencer sofrware
you are using.

* Ifyou install OMS after installing the UM-2 driver, you must install the UM-2 driver once again.

If a UM-2EX is already connected to your Macintosh when you install the driver, a message like
the following will appear when the Macintosh is started up. Perform the steps described below as
appropriate for the message that is displayed.

If the screen indicates: .
“Software needed for the USB device “UM-2" Is not avallable. Would you like to look for
the software on the Internet?"-> click [Cancel].

Use the following procedure to install the UM-2EX driver.
1. With the UM-2EX left unconnected, start up Macintosh
* Disconnect all USB cables other than those for your keyboard and mouse, and restart your Macintosh.
2. Exit all currently running software (applications).
3. Prepare the CD-ROM. Insert the CD-ROM into the CD-ROM drive of your Macintosh.

4. Double-click the UM-2 Driver-E Installer icon (found in the Driver E (Mac OS 9) folder of the CD-
ROM) to start up the installer,
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5. Verify the Install Location, and click fInstall].

The installation Iocation will be shown differently depending on your system, Make sure that you
have selected the startup disk for the system you are currently using,

6. If a message like the following is displayed,

. This Installation requires your computer to
click [Contlnue]. . . . e restart after Instailing this software. Qlck
The other currently running software will exit, Continue to automatically quit alt other

and installation will continue. running applications. Qick Cancel to leave
your disks untouched.

I
[Ccontinue

7. A dialog box will indicate Installation was successful.
Click [Restart] to restart your Macintosh.

Next, make the driver settings.

* OMS users P
* FreeMIDI users T




H OMS settings
If you are using FreeMIDI, proceed to “FreeMIDI settings” (p. 30).

1. Set the UM-2EX’s ADVANCED (mode select) Switch to the ON position.

2. Connect the UM-2EX to your Macintosh.
* Connect the cable to the USB connector of the Macintosh itself, not to the USB connector of the keyboard.

* This unit is equipped with a protection circuit. A brief interval (a few seconds) after connecting the UM-
2EX is required before the unit will operate normally.

3. From the CD-ROM, drag the Driver E (Mac OS 8) - OMS Setting folder into the
Opcode - OMS Applications folder on the hard disk of your Macintosh to copy it

there. OMS Setting

4. In the Opcode - OMS Applications folder where you installed OMS, double-click 0 MS
OMS Setup to start it up.
OMS Setup

5. If a dialog box like the one shown here appears,

click [Turn It Off]. A confirmation dialog box m ApplaTalk ta0n. 1213 wsed for cannecting your competar-to
will then appear, so click [OK]. o Tl oot e e P rs: Betitesn

* We recommend that you turn off AppleTalk, by
selecting Chooser from the Apple menu.

Hyo Tern 101,

CAUTIOR.
stemftvare.

{optians- ] [reaveiton] |
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6. The Create a New Studio Setup dialog box will
appear. Click [Cancel].
If you accidentally clicked [OK], click [Cancel] in
the next screen.

Create aNew Studlo Setup

A studio setup document Iy & list of your MIDI
devices and cables batveen them

Youuse Ittotel! applications what's Inyour
stutlo

Cllck OX to have OMS automatically locate your
MIDI devices and bulld o new studlo setup
document.

7. Choose “Open” from the File menu. ] SWINTERNETERETT UH-2 NN B B
From the OMS Setting folder that you copied in
step 3, select the UM-2 file, and click [Open]. B Studio Patches pom ehy
A screen like the one shown here will appear.
D@:’ QuickTime Musko
& toroL -2
[ 9 wezrets
S 99 wizrez
8. From the Edit menu, select OMS MIDI Setup. SESSIINITTTT 0MS MID) Setup SERRIRNINEEY

In the OMS MIDI Setup dialog box that appears, i
check Run MID! In background, and click [OK]. A e
OB erinter

413 ]

3 Run MIDI in background

{¥hen “Run MIDI In background™ Is checked,
013 will retaln control of external ports used
by MIDI interfaces untll all 0MS applications
have quit.)

[ NewEasySetup ] [Errorlog ]
(Editcustamsetup ] [0k ||




9. From the File menu, choose Make Current,
1f you are unable to select Make Current, it has
already been applied, and you may continue to
the next step.

10, Verify that MIDI transmission and reception
can be performed correctly.
From the Studio menu, choose Test Studio.

11. When you move the mouse cursor near the

MIDI connector icon, the cursor will change toa
JHshape.
Click the MIDI connector icon shown in the
illustration. If the corresponding MIDI OUT
indicator of the UM-2EX blinks, the settings
have been made correctly.

12. Exit OMS Setup.
From the File menu, choose [Exit]. If the

A diamond mark () Indicates the settings are enabled.

] o= |

B Studio Patehes pm chy
E@J'ozwrmmﬁ
] oROLM-2
[ €9 wezrwts
25 @ urzretz

Kl

] ST ol AR e B E|

B Stoio Patches pom chg
E@J‘ QuickTime Musto
& mroLu-2
oz v’
GBS 0 wezeat2

W+2Port 1

D]

AppleTalk confirmation dialog box appears, click [OK] to close the dialog box.
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W FreeMIDI settings
1. Set the UM-2EX’s ADVANCED (mode select) Swltch to the ON position.

2, Connect the UM-2EX to your Macintosh.
* Connect the cable to the USB connector of the Macintosh itself, nok to the USB connector of the keyboard.

* This unit is equipped with a protection circuit. A brief interval (n few seconds) after connecting the UM-
2EX is required before the unit will operate normally.

3. From the CD-ROM, drag the Driver E (Mac OS 9) - FreeMIDI Setting folder into the FreeMIDi
Applications folder on the hard disk of your Macintosh to copy it there.

4. Open the FreeMIDI Applications folder from the location into which you installed FreeMIDI, and
double-click the FreeMIDI Setup icon to start it up.
‘When “OMS is Installed on this | ...” appears, click [FreeMIDI].

5. The first time you start up, use the following procedure.

1. A dialog box saying “Welcome to FreeMIDII" will appear.
Click [Continue].

2. The FreeMIDI Preferences dialog box will appear.
Click [Cancel].

3. The About Quick Setup dialog box will appear.
Click [Cancel].
6. From the File menu, choose Open.
If you are unable to select Open, return to step 4 and continue the procedure.
1. From the File menu, choose FreeMIDI Preference.
2. Uncheck “Use OMS when avallable.”
3. Close FreeMIDI
7. Select UM-2 from the FreeMID] Setting folder you copied in step 3, and click [Open].

8. Verify that MIDI transmission and reception occur correctly.
From the MIDI menu, choose Check Connectlons.
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9. The mouse cursor will change to the shape of a HAIIHARDING t1-2 e s,

keyboard.

Click the jcon shown in the illustration. If the
corresponding MIDI OUT indicator of the UM-
2EX blinks, the settings have been made
correctly.

f—
U2, U2 Pert

w

I

k0]

10. Once again choose the MID] menu command Check Connections to end the test.
11.From the File menu, choose Quit to exit FreeMIDI Setup.

<Dy

31



. Basic Use

This chapter describes different basic methods of connecting the UM-2EX according to how the
UM-2EX is to be used.

Basic Connections and MIDI Flow

Transmitting MID]I messages from a MIDI keyboard or digital
piano to the sequencer software

To transmit MIDI messages from a MIDL keyboard or digital piano to the sequencer software or
make a MIDI recording of a keyboard performance or other performance using sequencer
software on your computer, make the following connections and settings.

MID] Keyboard
E
. [l )
'\ & MIDIIN &
MIDI are g A
1o the sequencer softwaro. Connectto the Connect to the MIDI OUT connector | (>
computer's of the MIDI keyboard or digital piano.
USB connector. our

<= MIDI Message Flow

MIDI device setting
Specify UM-2 MIDI 1 for MID! IN,
* Make the device settings within the sequencer software.
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Transmitting MIDI Messages from the sequencer s;ft;fvure toa
MIDI sound module or digital piano

If transmitting MIDI messages from the sequencer software to a MIDI sound module or digital
piano, or if using a MIDI sound module’s or digital piano’s sound generator to play the sounds
from the playback of sequencer software on the computer, make the following connections and

settings.
— Connect to the MIDI IN
Connect to the connector of the MIDI sound
computer's module or digital plano.
USB connector.
ToES @
s 80
MID! Sound Module
=
MIDI messages are transmitted
{from the sequencer software.

MID! Message Flow =)

Digital Plano

MIDI device setting
If you connected your device to the MIDI OUT 1 connector, specify UM-2 MIDI 1 for MIDI OUT.
If you connected your device to the MIDI OUT 2 connector, specify UM-2 MIDI 2.
For more on how to make the settings, refer to “Getting Connected and Installing Drivers”
(Windows: p. 10 / Macintosh: p. 20).

* Ifyou are using sequencer software that does not utilize Windows or Macintosh standard device settings, make
the device settings within the sequencer software,
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I Appendices

About Standard Driver Mode

Use this mode when using the standard MIDI driver provided with the operating system.
* Standard driver mode supports only Windows XP SP2 or later, and Mac OS5 X.
If you are using Windows 98/Me/2000/XP or XP SP1, or If you are using Mac OS 9, you must
ADVANCED (mode select) Switch ON before you connect the UM-2EX to you
compute

lnstalluhon of the standard driver

1. With the UM-2EX left unconnected start up your computer,
* Disconnect all USB cables other than those for your keyboard and mouse, and restart your Macintosh.
2, Exit all currently running software (applications).
3. Set the UM-2EX's ADVANCE DRIVER switch (mode switch) to OFF.
4. Connect the UM-2EX to the computer.
The driver is automatically installed.
* This unit is equipped with a protection circuit, A brief interval (a few seconds) after connecting the UM-
2EX is required before the unit will operate normally.

-
! Standard driver seﬂmgs

These settings enable use of the UM-2EX with sequencer software that uses Windows or
Macintosh standard device settings.

If using sequencer software that does not utilize Windows standard device settings, make the
device settings within the sequencer software. For instructions on the device settings for your
particular sequencer software, refer to the owner’s manual that was supplied with it.

When using Windows XP

1. In accordance with Step 1 in “Windows XP users” (p. 17), open the Audio tab in the Sounds and
Audio Devices Properties dialog box.

2. Click the ¥ for [Default device] in the MID] muslic playback menu and select the USB audio
devlce from the list that appears.
Depending on your computing environment, “(2)” or some other number may be added at the end
of the port name.

When using Macintosh (Mac OS5 X)
The procedure is the same as for Advanced mode. Refer to “Setting the driver” (p. 22).

34




lTroubIeshooting

If you experience problems, read this chapter first, It contains tips for solving most problems.

* For details on operating your Windows or Macintosh computer, refer to the owner’s manual of the
computer and operating systent you are using.

Problems Related to the USB Driver

Cannot install the driver correctly

Install the UM-2 driver once again as described in Getting Connected and Installlng Drlvers
(Windows) (p. 10) or Getting Connected and Installing Drivers (Macintosh) (p. 20).

Is the UM-2EX connected correctly?
Make sure that the USB connector of your computer is connected to the UM-2EX,

Could any other USB device be connected?
Before you install, disconnect all USB devices except for your mouse and keyboard.

Could other software or resident software (such as antivirus programs) be running?
Installation may not be successful if other programs are running.
Be sure to close all other programs before installation.

Is the CD-ROM correctly inserted into your CD-ROM drive?
Installation is not possible unless the CD-ROM included with the UM-2EX is inserted in your CD-
ROM drive. Make sure that the CD-ROM is correctly inserted into your CD-ROM drive.

Are you attempting to install from a networked CD-ROM drive?
You cannot install from a networked CD-ROM drive.

Is the CD-ROM or the lens of the CD-ROM drive dirty?
If the CD-ROM or the lens of the CD-ROM drive is dirty, the installer may not work correctly.
Clean the disc and/or lens using a commercially-available CD cleaner or lens cleaner.
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Is your puter’s power- vation mode turned off?
If power-conservation settings are enabled on your computer, please disable any such settings.
For the procedure, refer to the owner’s manual of your computer.

Is there sufficient free space on your hard disk?
Delete unneeded files to increase the amount of free space. After deleting the unneeded files,
empty the recycling bin.

Could the UM-2EX’s ADVANCED (mode select) Switch be OFF?
Turn the UM-2EX’s ADVANCED (mode select) Switch ON, restart Windows, and re-install the
driver.

Does your computer or USB hub have sufficient power supply capacity?
‘The UM-2EX cannot be connected if insufficient power is supplied to it. Check whether one of the
following cases apply.
» If you are using the UM-2EX with a notebook computer that is running on its battery,
operation may be unreliable with some models of computer. If this is the case, connect the
AC adaptor to your notebook computer,
* The power conservation mode of your computer may limit the power that is supplied to
USB. Check the settings of your computer.
 In some cases, the UM-2EX cannot be used with a bus-powered hub (a hub that does not
contain a power supply). Please use a self-powered hub (a hub that contains a power
supply).
Is USB enabled on your computer?
Refer to the operation manual for your computer, and make sure that USB is enabled.

Does your computer meet the USB specifications?
If you are using a computer that does not fulfill the electrical requirements of the USB
specifications, operation may be unstable. In this case, you may be able to solve the problem by
connecting a USB hub.

In the Device Manager, do you see “Other device,” “Unknown device,” or a device
for which #27, “1” or “x” is displayed? (Windows)
If the driver installation could not be successfully completed, the installed driver may remain in an
incomplete state.
Re-install the driver. (=“Installing the Driver” (p. 11))

Is OMS or FreeMIDI installed? (Mac OS 9)
The UM-2 driver cannot be installed unless OMS or FreeMIDI are installed. Please install OMS or
FreeMIDL



Windows XP/2000 displays a “Hardware Installation” or “Digital
Signature Not Found” dialog box

Did you make “Driver Signing Options”?
In order to install/re-install the driver, you must make the settings described in “Driver Signing
Options” (p. 11).

You are asked to instail the driver}ile;;ren IhouMQh you installeci ;he driver
(Windows)

Did you connect the UM-2EX to a different USB connector than the one you used when
installing the driver?
If your computer or USB hub has two or more USB connectors, and you connect the UM-2EX to a
different USB connector, you may be asked for the driver file even though the driver has already
been installed in your computer. (Such a response does not indicate a malfunction.)
Proceed as follows to install the driver.

1. Connect the UM-2EX to the computer.

Windows XP:

1. The Found New Hardware Wizard dialog box will appear.
If the message “Connect to Windows Update to search for software?” appears, choose “No”
and then click [Next].

2. Choose “Install the software automatically (Recommended)” and click [Next].
If a dialog box with an “1” or “x” symbol will appear, click [Continue Anyway] to proceed with
the installation, If you are unable to continue, click [OK] and repeat the driver installation.
(=>"Installing the Driver” (p. 11))

Windows 2000:
If a dialog box indicating “Dlgital Signature Not Found” will appear, click [Yes] to proceed
with the installation. If you are unable to continue, click [OK] and repeat the driver installation.
(=“Installing the Driver” (p. 11))
2, The Completing the Found New Hardware Wizard dialog box will appear,
Click [Finish].
3. If the Change System Settings dialog box appears, click [Yes]. Windows will restart
automatically.

If you are unable to complete driver installation using the above method, repeat the driver
installation. (“Installing the Driver” (p. 11))

.

37



“Find new hardware wizard” does not execute automatically
“Find new hardware wizard” ends before the process is completed

“Found unknown device” appears even though you installed the driver
’ (Windows)

Is the USB cable connected correctly?
Make sure that the UM-2EX’s USB cable and your computer are correctly connected.
It may take about 15seconds (or more) after the USB cable is connected.

Does your computer or USB hub have sufficient power supply capacity?
The UM-2EX cannot be connected if insufficient power is supplied to it. Check whether one of the
following cases apply.
* If you are using the UM-2EX with a notebook computer that is running on its battery, operation
may be unreliable with some models of computer. If this is the case, connect the AC adaptor to
your notebook computer.

 The power conservation mode of your computer may limit the power that is supplied to USB.
Check the settings of your computer.
¢ In some cases, the UM-2EX cannot be used with a bus-powered hub (a hub that does not contain a
power supply). Please use a self-powered hub (a hub that contains a power supply).
Is USB enabled on your p
Refer to the operation manual for your computer, and make sure that USB is enabled.

Does your computer meet the USB specifications?
If you are using a computer that does not fulfill the electrical requirements of the USB

specifications, operation may be unstable. In this case, you may be able to solve the problem by
connecting a USB hub.,
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UM-2EX is not detected when making OMS or FreeMIDI settings
(Mac OS 9 users)

Is the UM-2EX detected?
¢ Reconnect the UM-2EX.
o If other USB devices are connected, connect only the UM-2EX,
e Itis possible that the Macintosh did not correctly detect and initialize the UM-2EX. Leave the
UM-2EX connected, and restart your Macintosh. If it is still not detected, shut down your
Macintosh, and then restart it.

¢ In some cases, the UM-2EX will not be detected if you have connected it to the USB connector
located on the keyboard of the Macintosh. Please connect it to a USB connector on the
Macintosh itself.
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Deleting the Driver

If you were unable to install the driver according to the procedure given, the UM-2EX may not be
recognized correctly by the computer. In this case, use the following procedure to delete the
driver, and then follow the procedure to install the driver once again.

Windows users

1. Start up Windows with the UM-2EX disconnected.
Disconnect all USB cables other than a USB keyboard or USB mouse.

* Ifyou are using Windows XP Professional/2000, log on as a user that has administrative privileges (e.g.,
Administrator),

2. Insert the CD-ROM into the CD-ROM drive of your computer.

3. From the Windows Start menu, choose “Run....”
In the Run dialog box, input the following into the Open field, and click [OK].

Windows XP/2000 users: D:\DriveXP2K\Uninstal.exe
Windows Me/98 users: D:\Driver\Me98\Uninstal.exe

* The drive name is “D:” in the example shown here, but may be different on your system. Use the drive
nanze for your CD-ROM drive.

4. Follow the on-screen instructions to uninstall the driver,
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Macintosh {(Mac OS X) users

1. Start up Macintosh with the UM-2EX disconnected.
Disconnect all USB cables other than a USB keyboard or USB mouse.

2, Prepare the CD-ROM.
Insert the CD-ROM into the CD-ROM drive of your Macintosh.

3. In the Driver (Mac OS X) folder of the CD-ROM, double-click “UM2_Uninstaller.”

4. Thedisplay will indicate “This uninstalls EDIROL UM-2 driver from this Macintosh.”; click
[Uninstall].
If any other message appears, proceed as directed by that message.

5. The display will indicate “Are you sure to uninstall the driver?”; click [OK].
6. The "Authenticate” dialog box will appear; enter the password and click [OK].

7. The display will indicate “Uninstllation is completed.”; click [Restart]. Your Macintosh will
then restart.

Macintosh (Mac OS 9) users

1. Start up Macintosh with the UM-2EX disconnected.
Disconnect all USB cables other than a USB keyboard or USB mouse.

2. From the system extenslons folder inside the System folder, drag “USB UM-2 Driver” into
the trash to delete it.

3. Delete UM-2 from the OMS Folder inside the System folder, or drag UM-2 Driver from the
FreeMID] Folder inside the System folder to the trash.

4. Restart the Macintosh.
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Problems When Using the UM-2EX

Sound is interrupted during MIDI playback

In Windows, did you make the setting described in “Giving priority to background
services”?
In order to ensure that MIDI processing occurs smoothly, make the setting described inGlving
priority to Background Services. (3Windows XP (p. 14) / Windows 2000 (p. 15))

Did you plug in the USB cable, or unplug it while an software was running?
Exit all software that are using the UM-2EX, and re-connect the UM-2EX.

Is your computer in Suspend or Sleep mode?
If so, get your computer to resume normal operation, then exit all software that are using the UM-
2EX. Next re-connect the UM-2EX.

Are you running multiple software?
If multiple software are running simultaneously, an error message may appear. If this occurs, click
[OK] and exit the other software.
Even if an software window is closed, it is still running if it appears in the taskbar. Be sure to exit
unneeded software displayed.

Ll{luybgéi(‘or Egcorging halts midway through, and then becomes impossible

Was a heavy processing load experienced while using the UM-2EX, such as accessing
the CD-ROM drive or a network?
If an operation involving a heavy processing load is performed while the UM-2EX is in use, it may
not operate correctly. If this occurs, stop playback/recording, and then try resuming playback/
recording. If you are still unable to play back/record, exit all software that use the UM-2EX,
disconnect the UM-2EX from the computer and then reconnect it.

Operating system becomes unstable

Operation becomes unstable when the computer is started up with the UM-2EX
already connected
Please start up your computer with the UM-2EX disconnected, and then connect the UM-2EX. On
a computer that uses a USB keyboard, starting up the computer with the UM-2EX already
connected may cause operation to become unstable. In this case, start up the computer with the
UM-2EX disconnected, and then connect the UM-2EX.
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l Main Specifications

H UM-2EX: USB MIDI Interface

Controllers
ADVANCED switch

Connectors
MIDIIN Connector x 1 (16 MIDI Channels)
MIDI OUT Connector x 2 (32 MIDI Channels)
USB Cable

Power Supply
Supplied from the computer

Current Draw
70 mA

Dimensions

81 (W) x 47 (D) x 28 (H) mm

3-3/16 (W) x 1-7/8 (D) x 1-1/8 (H) inches
Weight

110g/ 40z

Accessories
Owner’s Manual
CD-ROM

* In the interest of product improvement, the specifications, appearance, andjor contents of this unit are
subject to change without prior notice.
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France
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(NORTH AMERICA)
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U.S. A,

Roland Corporation U.S.
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Shanghal200090,CHINA  Lov a3 o3 0501 A&BMusicSupplies LTD  HONDURAS
TEL: (021) 5580-0500 @ 12Webstec Industral Park. s cen pajaro Azut S.0. de C
Roland Sh + Bectroni TAIWAN Wildey, StMichael, Batbados g5 p.7 Barahona
Roland Shangha ™ ROLAND TAIWAN TEL: (246)430-1100 3 Aveill CalleS.0
(BEIJING OFFICE ENTERPRISE CO, LTD, BRAZIL San Pedro Sula, Honduras
10F, No.183 Section Anhuaxili s“°°1 "‘jﬁ;’; D2Chu"8  Roland Brasil Ltda, TEL: (504) 5532029
Chaoyang District Beyjing TAIWAN, RO.C. aipel, Rua San Jose, 780 Sala B MARTINIQUE
100011 CHINA TEL (02 3361339 Parque Industrial San Jose Musique & Son
TEL: (010) 6426-5050 (©2) Cotia-520 Paulo-SP, BRAZIL 5yt Mangle
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